Configuring and Managing Printing in Oracle® Solaris 11.1
Ce logiciel et la documentation qui l'accompagne sont protégés par les lois sur la propriété intellectuelle. Ils sont concédés sous licence et soumis à des restrictions d'utilisation et de divulgation. Sauf disposition de votre contrat de licence ou de la loi, vous ne pouvez pas copier, reproduire, traduire, diffuser, modifier, breveter, transmettre, distribuer, exposer, exécuter, publier ou afficher le logiciel, même partiellement, sous quelque forme et par quelque procédé que ce soit. Par ailleurs, il est interdit de procéder à toute ingénierie inverse du logiciel, de le désassembler ou de le décompiler, excepté à des fins d'interopérabilité avec des logiciels tiers ou tel que prescrit par la loi.

Les informations fournies dans ce document sont susceptibles de modification sans préavis. Par ailleurs, Oracle Corporation ne garantit pas qu'elles soient exemptes d'erreurs et vous invite, le cas échéant, à lui en faire part par écrit.

Si ce logiciel, ou la documentation qui l'accompagne, est concédé sous licence au Gouvernement des États-Unis, ou à toute entité qui délivre la licence de ce logiciel ou l'utilise pour le compte du Gouvernement des États-Unis, la notice suivante s'applique:

U.S. GOVERNMENT END USERS. Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

Ce logiciel ou matériel a été développé pour un usage général dans le cadre d'applications de gestion des informations. Ce logiciel ou matériel n'est pas conçu ni n'est destiné à être utilisé dans des applications à risque, notamment dans des applications pouvant causer des dommages corporels. Si vous utilisez ce logiciel ou matériel dans le cadre d'applications dangereuses, il est de votre responsabilité de prendre toutes les mesures de secours, de sauvegarde, de redondance et autres mesures nécessaires à son utilisation dans des conditions optimales de sécurité. Oracle Corporation et ses affiliés déclinent toute responsabilité quant aux dommages causés par l'utilisation de ce logiciel ou matériel pour ce type d'applications.

Oracle et Java sont des marques déposées d'Oracle Corporation et/ou de ses affiliés. Tout autre nom mentionné peut correspondre à des marques appartenant à d'autres propriétaires qu'Oracle.

Intel et Intel Xeon sont des marques ou des marques déposées d'Intel Corporation. Toutes les marques SPARC sont utilisées sous licence et sont des marques ou des marques déposées de SPARC International, Inc. AMD, Opteron, le logo AMD et le logo AMD Opteron sont des marques ou des marques déposées d'Advanced Micro Devices. UNIX est une marque déposée de The Open Group.

Ce logiciel ou matériel et la documentation qui l'accompagne peuvent fournir des informations ou des liens donnant accès à des contenus, des produits et des services émanant de tiers. Oracle Corporation et ses affiliés déclinent toute responsabilité ou garantie expresse quant aux contenus, produits ou services émanant de tiers. En aucun cas, Oracle Corporation et ses affiliés ne sauraient être tenus pour responsables des pertes subies, des coûts occasionnés ou des dommages causés par l'accès à des contenus, produits ou services tiers, ou à leur utilisation.
Contents

Preface ..................................................................................................................................................... 5

1 Setting Up and Administering Printers by Using CUPS (Overview) .................................................. 7
  Introduction to CUPS .......................................................................................................................... 7
  CUPS Processes .................................................................................................................................. 8
  CUPS Services ..................................................................................................................................... 8
  Setting Up Printers and Print Queues by Using CUPS ................................................................. 9
  Managing Print Requests by Using CUPS .................................................................................... 9

2 Setting Up Printers by Using CUPS (Tasks) ...................................................................................... 11
  Setting Up Your Printing Environment to Work With CUPS ...................................................... 11
    ▼ How to Set Up Your Printing Environment ................................................................................ 12
    Setting Up Your Printing Environment for an Upgrade ......................................................... 13
  Setting Up Printers by Using CUPS Command-Line Utilities (Task Map) ................................. 14
  Setting Up and Administering Printers by Using CUPS Command-Line Utilities ................. 15
    CUPS Command-Line Utilities ................................................................................................. 15
    ▼ How to Set Up a Printer by Using the \lpadmin Command .................................................... 16
    Setting a Default Printer .............................................................................................................. 17
    ▼ How to Verify the Status of Printers ......................................................................................... 20
    ▼ How to Print a File to the Default Printer ............................................................................... 22
    ▼ How to Delete a Printer and Remove Printer Access ............................................................ 22
  Setting Up Network Printers by Using CUPS Commands ............................................................ 24
  Setting Up and Administering Printers by Using the CUPS Web Browser Interface (Task Map) ................................................................................................................................. 26
  Setting Up and Administering Printers by Using the CUPS Web Browser Interface ............... 26
    Requirements for Using the CUPS Web Browser Interface .................................................... 27
    Troubleshooting Issues With Accessing the CUPS Web Browser Interface .......................... 27
    Print Administration Tasks .......................................................................................................... 28

3
Preface

*Configuring and Managing Printing in Oracle Solaris 11.1* is part of a documentation set that provides a significant portion of the Oracle Solaris system administration information.

This book assumes you have completed the following tasks:

- Installed the Oracle Solaris 11 software
- Set up all the networking software that you plan to use

**Note** – This Oracle Solaris release supports systems that use the SPARC and x86 families of processor architectures. The supported systems appear in the *Oracle Solaris OS: Hardware Compatibility Lists*. This document cites any implementation differences between the platform types.

In this document, these x86 related terms mean the following:

- x86 refers to the larger family of 64-bit and 32-bit x86 compatible products.
- x64 relates specifically to 64-bit x86 compatible CPUs.
- "32-bit x86" points out specific 32-bit information about x86 based systems.

For supported systems, see the *Oracle Solaris OS: Hardware Compatibility Lists*.

Access to Oracle Support

Typographic Conventions

The following table describes the typographic conventions that are used in this book.

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories, and onscreen computer output</td>
<td>Edit your .login file. Use \ls -a to list all files. <code>machine_name% you have mail</code>.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>What you type, contrasted with onscreen computer output</td>
<td><code>machine_name% su</code> Password:</td>
</tr>
<tr>
<td>aabbcc123</td>
<td>Placeholder: replace with a real name or value</td>
<td>The command to remove a file is <code>rm filename</code>.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new terms, and terms to be emphasized</td>
<td>Read Chapter 6 in the User’s Guide. A cache is a copy that is stored locally. Do not save the file. <strong>Note:</strong> Some emphasized items appear bold online.</td>
</tr>
</tbody>
</table>

Shell Prompts in Command Examples

The following table shows UNIX system prompts and superuser prompts for shells that are included in the Oracle Solaris OS. In command examples, the shell prompt indicates whether the command should be executed by a regular user or a user with privileges.

<table>
<thead>
<tr>
<th>Shell</th>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bash shell, Korn shell, and Bourne shell</td>
<td>$</td>
</tr>
<tr>
<td>Bash shell, Korn shell, and Bourne shell for superuser</td>
<td>#</td>
</tr>
<tr>
<td>C shell</td>
<td><code>machine_name%</code></td>
</tr>
<tr>
<td>C shell for superuser</td>
<td><code>machine_name#</code></td>
</tr>
</tbody>
</table>
Setting Up and Administering Printers by Using CUPS (Overview)

This chapter includes overview information for managing your printing environment by using the Common UNIX Printing System (CUPS), including how to transition to using CUPS if you previously used the LP print service to manage printers. The interfaces that are described in this chapter include the CUPS command-line utilities, the CUPS web browser interface, and CUPS Print Manager, a GUI that can be accessed in the desktop.

Introduction to CUPS

CUPS is a modular and open-source printing system that uses the Internet Printing Protocol (IPP) as the basis for managing printers, print requests, and print queues. CUPS supports network printer browsing and PostScript Printer Description-based printing options. CUPS also provides a common printing interface across a local network.

IPP is the standard protocol for printing on a network. Similar to other IP-based protocols, IPP can be used locally or over the Internet to communicate with remote printers. Unlike other protocols, IPP also supports access control, authentication, and encryption, making it a much more capable and secure printing solution than other protocols. IPP is layered on top of the Hypertext Transfer Protocol (HTTP). HTTP is the basis for web servers that are on the Internet. When IPP is in use, you can verify printer or server status information and manage printers and print jobs through a browser. CUPS is a complete IPP/1.1 based printing system that provides basic, digest, and local certificate authentication and user, domain, or IP-based access control.

CUPS includes support for dynamic printer detection and grouping. CUPS replaces the \( \text{lpr} \) command with its own command and the LPD printer drivers with its own print drivers. CUPS is similar to the LP print service in that it uses PostScript format as its underlying language for page descriptions. Because CUPS provides both the System V and Berkeley print commands, users and applications can print to CUPS queues with little or no changes to the options that were previously used.

Lastly, CUPS includes application-level interfaces that are used by many open-source applications and toolkits. On the back end, CUPS includes the necessary interfaces for
processing the annotated raster image format (RIP). Support for this format and these interfaces is integrated into other critical open-source print driver technologies.

CUPS is the default and the only print service in the Oracle Solaris release, replacing the LP print service. Printing in the Oracle Solaris operating system (OS) by using CUPS is managed by using the following:

- CUPS command-line utilities – These commands include new CUPS print commands, as well as some print commands that were previously used by the LP print service.
- CUPS Print Manager GUI – You can access the GUI from the Oracle Solaris Desktop, which includes GNOME 2.30, or by typing the system-config-printer command in a terminal window.

**CUPS Processes**

For CUPS to manage your printing environment, you must first create a print queue under CUPS. The print queue might point to a printer that is connected directly to your system through a USB port or a parallel port. However, the queue can also point to a printer on the network, a printer on the Internet, or multiple printers, depending on how you have configured the application. Regardless of where the queue points, the print queue is treated like any other printer.

**CUPS Services**

CUPS services are provided through two new Service Management Facility (SMF) services:

- **svc:/application/cups/scheduler**
  This service manages the cupsd daemon. This daemon provides basic printing services that include queueing, filtering, spooling, notification, IPP support, device enumeration, and web management.

- **svc:/application/cups/in-lpd**
  This service runs the cups-lpd daemon. This daemon provides basic RFC-1179 (LPD protocol) support for the CUPS service.

The Printer Management profile and the solaris.smf.manage.cups authorization enable users who do not have a root account to manage these SMF services.
Setting Up Printers and Print Queues by Using CUPS

For CUPS to manage your printing environment, you must first create a print queue under CUPS.

You can create a new print queue in one of the following ways:

- Use the `lpadmin` command to manually create the print queue. For more information, see the `lpadmin(8)` man page.
- Use the Print Manager GUI, which can be accessed from the Oracle Solaris Desktop. For more information, see “Setting Up Printers by Using CUPS Print Manager (Task Map)” on page 32.
- Physically connect a USB printer to your local system.

If CUPS is enabled on your system, the hardware abstraction layer (HAL) and the `hal-cups-utils` utility recognize the USB printer hot-plug events. They can recognize new printers that are connected to your local system. The `hal-cups-utils` utility automatically creates a print queue under CUPS for the new printer.

In addition, CUPS supports printer discovery by using the mDNS framework (Bonjour) and SNMP. CUPS can discover printers that are shared by other CUPS servers through the CUPS browsing feature. For more information, go to `http://www.cups.org/documentation.php/doc-1.5/options.html`.

- For network print queues, enable the CUPS “browse feature” (the default) on your system. If another system on the network advertises an available printer on the remote system, CUPS detects the printer, and a new print queue is created.

Managing Print Requests by Using CUPS

Every time you submit a print request, CUPS creates a print job that contains information about the print queue to which you are sending the request, the name of the document, and the page description. Print jobs are numbered, for example, `queue-1`, `queue-2`, so that you can monitor each print job as it is printed or cancel the print job, if necessary.

When a print request is submitted, CUPS does the following:

1. Determines which programs to use (filters, print drivers, port monitors, and back-end programs).
2. Runs these programs to complete the print job.
3. Removes the job from the print queue when the print job is complete, and then prints the next print job that is submitted. You can configure CUPS to notify you when a print job is complete or if any errors occur during printing.
Setting Up Printers by Using CUPS (Tasks)

This chapter includes information for managing your printing environment by using the Common UNIX Printing System (CUPS), including how to transition to using CUPS if you previously used the LP print service to manage printers. The interfaces that are described in this chapter include the CUPS command-line utilities, the CUPS web browser interface, and CUPS Print Manager, a GUI that can be accessed in the desktop.

This is a list of the information that is in this chapter:

- “Setting Up Your Printing Environment to Work With CUPS” on page 11
- “Setting Up and Administering Printers by Using CUPS Command-Line Utilities” on page 15
- “Setting Up and Administering Printers by Using the CUPS Web Browser Interface (Task Map)” on page 26
- “Setting Up Printers by Using CUPS Print Manager (Task Map)” on page 32

Setting Up Your Printing Environment to Work With CUPS

In previous Oracle Solaris releases, the LP print service was the default print service. Starting with the Oracle Solaris 11 release, the LP print service is removed. The default and only available print service in Oracle Solaris 11 is CUPS. If you are performing a fresh installation of Oracle Solaris 11 and have any existing printers that were configured by using the LP print service, you need to reconfigure those printers by using CUPS after the installation.

If you are upgrading from Oracle Solaris 11 Express to Oracle Solaris 11, see “How to Set Up Your Printing Environment” on page 12.

Switching to the CUPS print environment has resulted in the following changes:

- Any existing printers that were configured by using the LP print service will no longer work and must be reconfigured.
You can reconfigure printers by using any one of the following methods:

- By using the `lpadmin` command. For information, see “How to Set Up a Printer by Using the `lpadmin` Command” on page 16.
- By using CUPS Print Manager. For information, see “Setting Up Printers by Using CUPS Print Manager” on page 33.

Printer configuration that was previously stored in the NIS naming service is not used by CUPS. Administrators can share network printers that are configured by using the CUPS shared-printer feature. CUPS auto-discovers printers on a network and enables you to print to these printers without any manual configuration. For information about sharing printers by using CUPS Print Manager, see “Remote Server Configuration” on page 33.

Printers that are configured on a per-user basis in the `~/.printers` file no longer work. Printer configuration is managed by using the CUPS web browser interface, the CUPS command-line utilities, or the CUPS Print Manager graphical user interface.

In previous releases, the `/etc/printers.conf` file contained details about all of the printers that were added by using the LP print service. With the removal of the LP print service in the Oracle Solaris 11 OS, this file still exists under CUPS but contains a summary of the local print queues. After installing the OS, any information about printers that were previously configured by using `lp` print commands is removed. The resulting behavior is as though these printers were never configured on the system. Any existing printers must be reconfigured by using CUPS. You do not need to delete existing printers prior to reconfiguring these printers by using CUPS. For information about setting up your printing environment to work with CUPS, see “How to Set Up Your Printing Environment” on page 12.

### How to Set Up Your Printing Environment

To transition your current printing environment to work with CUPS, you must reconfigure your existing printers.

1. **Ensure that the `cups/scheduler` and the `cups/in-lpd` SMF services are online.**

   $ svcs -a | grep cups/scheduler
   online 18:18:55 svc:/application/cups/scheduler:default

   $ svcs -a | grep cups/in-lpd
   online Sep_29 svc:/application/cups/in-lpd:default

2. **To enable these services, type the following commands:**

   # svcadm enable cups/scheduler
   # svcadm enable cups/in-lpd
3 Determine whether the printer/cups/system-config-printer package is installed on your system.

$ pkg info print/cups/system-config-printer

- If the package is already installed, configure your printer by using CUPS.
  Printers can be configured by using either the ladmin command, or by using the CUPS web browser interface at http://localhost:631, or by using CUPS Print Manager, which is accessible in the desktop.

- If the package is not installed, install the package.

$ pkg install print/cups/system-config-printer

See Also
Additional CUPS documentation can be found at:

Next Steps
You can now configure printers by using CUPS. You can set a default printer by specifying either the LPDEST or PRINTER environment variables, or by using the lpoptions command. For instructions, see "How to Set a Default Printer at the Command Line" on page 18 and Example 2–6.

Setting Up Your Printing Environment for an Upgrade

If you are running unmodified Oracle Solaris 11 Express, CUPS is already the default print service. If you upgrade to Oracle Solaris 11, you do not need to reconfigure any existing print queues by using CUPS. However, if you switched to the LP print service and configured printers by using the lpr print commands, you must reconfigure these existing printers by using CUPS after the upgrade.

Caution – If you are running the LP print service, be sure to back up your /etc/printers.conf file before upgrading, as the upgrade process removes this file.

To determine which print service is enabled on your system, type the following command:

$ /usr/sbin/print-service -q

Reconfigure your existing printers by using any one of the methods that is described in this chapter.
## Setting Up Printers by Using CUPS Command-Line Utilities (Task Map)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>For Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up a new locally attached printer.</td>
<td>You can set up a new locally attached printer by using the <code>lpadmin</code> command.</td>
<td>&quot;How to Set Up a Printer by Using the <code>lpadmin</code> Command&quot; on page 16</td>
</tr>
<tr>
<td>Set the default printer for a system at the command line.</td>
<td>You can set a default printer destination for a user by specifying the <code>LPDEST</code> and <code>PRINTER</code> environment variables, and by using the <code>lpoptions</code> command.</td>
<td>&quot;How to Set a Default Printer at the Command Line&quot; on page 18</td>
</tr>
<tr>
<td>Verify the status of printers.</td>
<td>You can verify the status of all printers or a specific printer by using the <code>lpstat</code> command. This command enables you to determine which printers are available for use and enables you to examine the characteristics of those printers.</td>
<td>&quot;How to Verify the Status of Printers&quot; on page 20</td>
</tr>
<tr>
<td>Print a file by using CUPS commands.</td>
<td>You can print a file by using the <code>lp</code> and <code>lpr</code> commands.</td>
<td>&quot;How to Print a File to the Default Printer&quot; on page 22</td>
</tr>
<tr>
<td>Delete a printer and remove printer access.</td>
<td>You can delete a printer and remove printer access by using the <code>lpoptions</code> command.</td>
<td>&quot;How to Delete a Printer and Remove Printer Access&quot; on page 22</td>
</tr>
<tr>
<td>Add a network printer that is on a different subnet.</td>
<td>You can add a network printer that is on a different subnet by using the <code>lpadmin</code> command. CUPS automatically discovers printers that are identified in the same subnet.</td>
<td>&quot;How to Add a Network Printer on a Different Subnet by Using CUPS Commands&quot; on page 24</td>
</tr>
<tr>
<td>List the available drivers and devices.</td>
<td>You can list the available drivers and devices by using the <code>lpinfo</code> command.</td>
<td>&quot;How to List the Available Drivers and Devices&quot; on page 25</td>
</tr>
</tbody>
</table>
Setting Up and Administering Printers by Using CUPS Command-Line Utilities

This section provides a brief description of the CUPS commands and describes how to set up and administer your printers.

CUPS Command-Line Utilities

CUPS provides various commands to set up printers and make those printers accessible to systems on the network. In addition, CUPS supports several printer-specific options that enable you to control printer configuration. The following table lists frequently used CUPS commands.

**Note** – Some CUPS command names are the same as legacy LP print commands, but the behavior of commands under CUPS management might be different.

<table>
<thead>
<tr>
<th>Command</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>cancel(1)</td>
<td>Cancels a print request</td>
</tr>
<tr>
<td>cupsaccept(8)</td>
<td>Enables queueing of print requests to the named destinations</td>
</tr>
<tr>
<td>cupsdisable(8)</td>
<td>Disables the named printers or classes</td>
</tr>
<tr>
<td>cupsenable(8)</td>
<td>Enables the named printers or classes</td>
</tr>
<tr>
<td>cupsreject(8)</td>
<td>Rejects queueing of print requests to the named destinations</td>
</tr>
<tr>
<td>lp(1)</td>
<td>Submits a print request</td>
</tr>
<tr>
<td>lpadmin(8)</td>
<td>Sets up or changes a printer or class configuration</td>
</tr>
<tr>
<td>lpc(8)</td>
<td>Provides limited control over CUPS print and class queues</td>
</tr>
<tr>
<td>lpinfo(8)</td>
<td>Shows available devices or drivers known to the CUPS server</td>
</tr>
<tr>
<td>lpmove(8)</td>
<td>Moves a specified job or all jobs to a new destination</td>
</tr>
<tr>
<td>lpoptions(1)</td>
<td>Displays or sets printer options and defaults</td>
</tr>
<tr>
<td>lpq(1)</td>
<td>Shows the current print queue status</td>
</tr>
<tr>
<td>lpr(1)</td>
<td>Submits a print request</td>
</tr>
<tr>
<td>lprm(1)</td>
<td>Cancels print jobs that have been queued for printing</td>
</tr>
<tr>
<td>lpstat(1)</td>
<td>Displays the status information for queues and requests</td>
</tr>
</tbody>
</table>
How to Set Up a Printer by Using the \texttt{lpadmin} Command

1. Connect the printer to the system, then turn on the power to the printer.
   Consult the printer vendor’s installation documentation for information about hardware switches and cabling requirements.

2. Become an administrator.
   For more information, see “How to Use Your Assigned Administrative Rights” in \textit{Oracle Solaris 11.1 Administration: Security Services}

3. Use the \texttt{lpadmin} command with the \texttt{-p} option to add a printer to CUPS.
   Only the most commonly used options of the CUPS \texttt{lpadmin} command are shown here. For information about other options, see the \texttt{lpadmin(8)} man page.
   \begin{verbatim}
   $ /usr/sbin/lpadmin -p printer-name -E -v device -P full path to ppd file
   \end{verbatim}
   \begin{itemize}
   \item \texttt{-p} Specifies the name of the printer to add.
   \item \texttt{-E} Enables the destination and accepts jobs.
   \item \texttt{-v} Sets the device-\texttt{uri} attribute of the print queue.
   \item \texttt{-P} Specifies a PPD (Postscript Printer Description) file to use with the printer. The following are standard locations of PPD files:
     \begin{itemize}
     \item /usr/share/cups/model/foomatic-db-ppds/manufacturer name
     \item /usr/share/cups/model/SUNWhplip
     \item /usr/share/ppd/SUNWhpljs/HP
     \end{itemize}
   \end{itemize}
   See the examples at the end of this procedure.

4. (Optional) If you are not using the \texttt{lpadmin} command with the \texttt{-E} option, enable the printer to accept print requests and to print those requests.
   \begin{verbatim}
   $ cupsaccept printer-name
   $ cupsenable printer-name
   \end{verbatim}

5. Verify that the printer is correctly configured.
   \begin{verbatim}
   $ lpstat -l -p printer-name
   \end{verbatim}

Example 2–1 Adding a Printer That Uses a PPD File

This example shows how to add an HP LaserJet printer LaserJet by using a JetDirect network interface with the IP address 10.1.1.1.
Once a printer is configured, a copy of the PPD file is placed in the /etc/cups/ppd directory and renamed to queue-name.ppd. To find the path this copy of the PPD file, type the following command:

```
# lpsstat -l -p queue-name
```

### Example 2–2 Adding a Printer That Is Connected to the Parallel Port

This example shows how to add an HP DeskJet printer DeskJet that is connected to the parallel port. This example assumes that the PPD file is in the /usr/share/cups/model directory.

```
$ /usr/sbin/lpadmin -p DeskJet -E -v parallel:/dev/lp1 -m drv:///sample.drv/deskjet.ppd
   -m deskjet.ppd Sets a PPD file for the printer
   PPD file for the HP DeskJet drivers included with CUPS
```

### Example 2–3 Adding a Printer That Is Connected to the Serial Port

This example shows how to add a dot matrix printer that is connected to the serial port. This example assumes that the PPD file is in the /usr/share/cups/model directory.

```
$ /usr/sbin/lpadmin -p DotMatrix -E -m epson9.ppd
   -v serial:/dev/ttyS0?baud=9600+size=8+parity=none+flow=soft
```

Specify the serial port, baud rate, number of bits, parity, and flow control. If you do not need flow control, delete the +flow=soft attribute.

### Setting a Default Printer

You can specify the default printer in one of the following ways:

- **By setting the LPDEST or PRINTER environment variable.**
  The LPDEST environment variable determines the destination of the printer. If the LPDEST variable is not set, the PRINTER variable is used. The PRINTER variable determines the output device or destination. For instructions on setting up a default printer by specifying the environment variables, see “How to Set a Default Printer at the Command Line” on page 18.

- **By using the new lqoptions command.**
  Use this command to display or set printer options and defaults. For instructions on setting up a default printer by using the CUPS commands, see “How to Set a Default Printer at the Command Line” on page 18. For more information, see the lqoptions(1) man page.
By using the `lpadmin` command.

The `print` command searches for the default printer in the following order:

1. The printer name as set by the `lp` command with the `-d` option
2. The value of the `LPDEST` environment variable
3. The value of the `PRINTER` environment variable
4. The printer name as set by the `lpoptions` command
5. The printer name as set by the `lpadmin` command

For instructions on setting up printers by using the CUPS web browser interface, see “Setting Up and Administering Printers by Using the CUPS Web Browser Interface” on page 26.

### How to Set a Default Printer at the Command Line

The default printer can be a local printer or a remote printer.

1. **Set the user's default printer by using one of the following methods:**

   - **By specifying the `PRINTER` variable:**
     
     ```
     $ export PRINTER=printer-name
     ```
     
     Where `printer-name` specifies the name of the printer to be assigned as the user's default printer.

     **Note** – When using the `lp` command with the `-d` option, the destination printer, which might not be the default printer, is specified. If the `-d` option is not specified, the `print` command searches for information about the printer in the `PRINTER` environment variable.

   - **By specifying the `LPDEST` variable:**
     
     ```
     $ export LPDEST=printer-name
     ```
     
     Where `printer-name` specifies the name of the printer to be assigned as the default printer.

     **Note** – If both the LPDEST and the PRINTER environment variables are set, LPDEST takes precedence.

   - **By using the `lpoptions` command:**
     
     ```
     $ lpoptions -d printer-name
     ```
     
     `-d` Specifies the destination printer.
     
     `printer-name` Specifies the name of the printer that is assigned as the user's default printer.
For more information, see the \texttt{lpop\_tions(1) man page.}

2 Verify the default printer.
   \texttt{$ \textit{lps\_t\_at -d}}

3 To print to the default printer, type the following command:
   \texttt{$ \textit{lp \_filename}}

Example 2–4 Setting a Default Printer by Specifying the PRINTER Variable

The following example shows how to set the printer \texttt{luna} as the default printer by using the PRINTER variable.

\texttt{$ \textit{export PRINTER\_luna}}
\texttt{$ \textit{lps\_t\_at -d}}
\texttt{system default destination: luna}

Example 2–5 Setting a Default Printer by Specifying the LPDEST Variable

The following example shows how to set the printer \texttt{luna} as the default printer by specifying the LPDEST variable.

\texttt{$ \textit{export L\_PDEST\_luna}}
\texttt{$ \textit{lps\_t\_at -d}}
\texttt{system default destination: luna}

Example 2–6 Setting a Default Printer by Using the \texttt{lpop\_tions} Command

The following example shows how to set the printer \texttt{luna} as the default printer. The printer \texttt{luna} is used as the default printer if the LPDEST or the PRINTER environment variable is not set.

\texttt{$ \textit{lpop\_tions -d luna}}
\texttt{$ \textit{lps\_t\_at -d}}
\texttt{system default destination: luna}

The \texttt{lpop\_tions} command creates a \texttt{~/.cups/lpop\_tions} file that includes an entry for the default printer \texttt{luna} in the file. By default, all print jobs are now directed to the \texttt{luna} printer. For a root user, the \texttt{lpop\_tions} command creates a \texttt{/etc/cups/lpop\_tions} file.

Example 2–7 Setting a Default Printer by Using the \texttt{lpop\_admin} Command

The following example shows how to set the printer \texttt{luna} as the default printer by using the \texttt{lpop\_admin} command.

Chapter 2 • Setting Up Printers by Using CUPS (Tasks) 19
$ lpadmin -d luna
$ lpstat -d
system default destination: luna

▼ How to Print to a Specified Printer

1 (Optional) Verify the status of the printer.
   $ lpstat -p printer-name

2 Provide the destination printer name when issuing the \texttt{lp} command.
   $ lp -d destination-printer filename
   \texttt{-d} Specifies the destination printer.
   \texttt{destination-printer} Specifies the name of the printer that you are assigning as the destination printer.
   \texttt{filename} Specifies the file name to print.

\textbf{Note} – You can also use the \texttt{lpr} command with the \texttt{-P} option to submit a print request to a specific printer. For more information, see the \texttt{lpr(1)} man page.

\textbf{Example 2-8} Printing to a Specified Printer by Using the \texttt{lp} Command

The following example shows how to set the printer \texttt{luna} as the destination printer.

$ lp -d luna abc.ps
request id is luna-1 (1 file(s))

$ lpstat -d
system default destination: saturn

The \texttt{-d} option of the \texttt{lp} command takes precedence over default printer settings.

Note that in this example, the default printer is \texttt{saturn}.

▼ How to Verify the Status of Printers

The \texttt{lpstat} command displays information about accessible printers and jobs.

1 Log in to any system on the network.
2  **(Optional) Verify the status of all printers or a specific printer.**

Only the most commonly used options are shown here. For information about other options, see the `lpstat(1)` man page.

```
$ lpstat [-d] [-l] [-p] printer-name [-t]
```

- `-d` Shows the default printer.
- `-p printer-name` Shows that a printer is active or idle, and when the printer was enabled or disabled.

You can specify multiple printer names with this command. Use a space or a comma to separate printer names. If you use spaces, enclose the list of printer names in quotation marks. If you do not specify `printer-name`, the status of all printers is displayed.

- `-l` Shows the characteristics of printers and jobs.
- `-t` Shows status information about CUPS, including the status of all printers, for example whether printers are active and accepting print requests.

**Example 2–9**  Displaying the Status of Printers

To display the status of the printer `luna`:

```
$ lpstat -p luna
printer luna is idle. enabled since Jul 12 11:17 2011. available.
```

To display the system’s default printer:

```
$ lpstat -d
system default destination: luna
```

To display the description of the printers `asteroid` and `luna`:

```
$ lpstat -p "asteroid, luna" -D
printer asteroid faulted. enabled since Jan 5 11:35 2011. available. unable to print: paper misfeed jam
Description: Printer by break room
printer luna is idle. enabled since Jan 5 11:36 2011. available. Description: Printer by server room.
```

To display the characteristics of the printer `luna`:

```
$ lpstat -l -p luna
printer luna is idle. enabled since September 29, 2011 05:20:57 PM BST
Form mounted: 
Content types: any
Printer types: unknown
Description: luna
```
How to Print a File to the Default Printer

1. Log in to any system on the network.
2. (Optional) Verify the status of the printer.
   $ lpstat -p printer-name
3. Issue a print request in one of the following ways:
   - By using the `lp` command:
     $ lp filename
   - By using the `lpr` command:
     $ lpr filename

Note – Only the basic commands are shown in this procedure. For information about the other options, see the `lp(1)` and `lpr(1)` man pages.

How to Delete a Printer and Remove Printer Access

1. Become an administrator on a print client with access to the printer to delete.
2. On the system that is the print client, delete information about the printer.
   $ lpoptions -x printer-name
   
   `printer-name` Specifies the name of the printer to delete.
   `-x` Deletes the specified printer.
Note – The -x option only removes the default options for a specific printer and instance. The original print queue still remains until it is deleted by using the `lpadmin` command.

3 Become an administrator.

4 On the system that is the printer server, stop accepting print requests for the printer.
   
   ```bash
   $ cupsreject printer-name
   ```
   
   This step prevents any new requests from entering the printer’s queue while you are in the process of removing the printer.

5 Stop the printer.
   
   ```bash
   $ cupsdisable printer-name
   ```

6 Delete the printer.
   
   ```bash
   $ lpadmin -x printer-name
   ```

7 Verify that the printer has been deleted, as follows:
   
   a. Confirm that the printer has been deleted on the print client.
      
      ```bash
      $ lpstat -l -p printer-name
      ```
      
      The command output displays a message indicating the printer does not exist.

   b. Confirm that the printer has been deleted on the print server.
      
      ```bash
      $ lpstat -l -p printer-name
      ```
      
      The command output displays a message indicating that the printer does not exist.

Example 2–10 Deleting a Printer

The following example shows how to delete the printer luna from the print client terra and from the print server jupiter.

```
terra# lpoptions -x luna
terra# lpstat -l -p luna
jupiter# lpadmin -x luna
jupiter# lpstat -l -p luna
lpstat: Invalid destination name in list "luna"
```
Setting Up Network Printers by Using CUPS Commands

A network printer is a hardware printing device that is connected directly to a network. A network printer has its own system name and IP address.

CUPS automatically discovers printers that are identified in the same subnet. Network printers that are not in the same subnet have to be added manually by the system administrator. You can configure a network printer by using the `lpadmin` command.

▼ How to Add a Network Printer on a Different Subnet by Using CUPS Commands

1. **Connect the printer to the network, then turn on the power to the printer.**
   Consult the printer vendor’s installation documentation for information about hardware switches and cabling requirements.

2. **Ping the network printer from your system.**
   ```
   # ping ip-address-of-network-printer
   ```

3. **Determine the make and model of the network printer.**
   ```
   # lpinfo --make-and-model printer manufacturer name
   ```
   For example, to list the Xerox printers:
   ```
   # lpinfo --make-and-model Xerox -m
   ```
   For more information, see “How to List the Available Drivers and Devices” on page 25.

4. **Use the `lpadmin` command to add the network printer.**
   ```
   # lpadmin -p printer-name -E -v socket://ip-address-of-network-printer
   -m printer-make-and-model
   ```
   -p Specifies the name of the printer to add.
   -E Enables the destination and accepts jobs.
   -v Sets the `device-uri` attribute of the print queue.
   -m Sets the PPD file for the printer from the model directory or by using one of the driver interfaces.
   
   For information, see the `lpadmin(8)` man page.

5. **Verify that the printer is correctly configured.**
   ```
   # lpstat -l -p printer-name
   ```
Adding a Network Printer That Is on a Different Subnet

The following example shows how to add the Xerox printer *luna* that is on a different subnet with IP address 10.178.236.21:

```bash
# ping 10.178.236.21
10.178.236.21 is alive

# lpinfo -m
foomatic:Xerox-2700 XES-xes.ppd Xerox 2700 XES Foomatic/xes
foomatic:Xerox-3700 XES-xes.ppd Xerox 3700 XES Foomatic/xes
foomatic:Xerox-4045 XES-xes.ppd Xerox 4045 XES Foomatic/xes
foomatic:Xerox-Phaser_5500DN-Postscript.ppd Xerox Phaser 5500DN Foomatic/Postscript\
gutenprint.5.2://xerox-able_1406/expert

# lpadmin -p luna -E -v socket://10.178.236.21 \ 
-m foomatic:Xerox-Phaser_5500DN-Postscript.ppd

# lpsstat -l -p luna
printer luna is idle. enabled since June 25, 2012 12:13:05 PM IST
printer luna is idle. enabled since September 29, 2011 05:20:57 PM BST
Form mounted:
Content types: any
Printer types: unknown
Description: luna
Alerts: none
Location:
Connection: direct
On fault: no alert
After fault: continue
Users allowed:
(all)
Forms allowed:
(none)
Banner required
Charset sets:
(none)
Default pitch:
Default page size:
Default port settings:
```

⚠️ How to List the Available Drivers and Devices

The *lpinfo* command lists the available devices and drivers known to the CUPS server.

1. **Log in to any system on the network.**
2. **List the available devices and drivers by using the *lpinfo* command.**
   - Use the `-m` option to list the available drivers.
     ```bash
     # lpinfo -m
     ```
Use the `-v` option to list the available devices.

```
# lpinfo -v
```

**Example 2–12  Listing the Available Drivers**

To list all Xerox printers:

```
# lpinfo --make-and-model Xerox -m
foomatic:Xerox-2700_XES-xes.ppd Xerox 2700 XES Foomatic/xes
foomatic:Xerox-3700_XES-xes.ppd Xerox 3700 XES Foomatic/xes
foomatic:Xerox-4045_XES-xes.ppd Xerox 4045 XES Foomatic/xes
gutenprint.5.2://xerox-able_1406/expert
Xerox Able 1406 - CUPS+Gutenprint v5.2.4
gutenprint.5.2://xerox-able_1406/simple
Xerox Able 1406 - CUPS+Gutenprint v5.2.4 Simplified
```

### Setting Up and Administering Printers by Using the CUPS Web Browser Interface (Task Map)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>For Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify requirements for using the web browser interface.</td>
<td>To access the CUPS web browser interface, the CUPS service must be enabled on your system, and CUPS packages must also be installed on your system.</td>
<td>&quot;Requirements for Using the CUPS Web Browser Interface&quot; on page 27</td>
</tr>
<tr>
<td>Add a new printer by using the CUPS web browser interface.</td>
<td>Use the Administration tab of the CUPS Print Manager GUI when you connect a new printer to your local system.</td>
<td>&quot;How to Add a New Printer&quot; on page 30</td>
</tr>
</tbody>
</table>

### Setting Up and Administering Printers by Using the CUPS Web Browser Interface

You can use the CUPS web browser GUI to manage your printing environment in Oracle Solaris 11. This section describes the requirements to use the web browser interface and the administration tasks that you can perform.
Requirements for Using the CUPS Web Browser Interface

To access the web browser interface, go to http://localhost:631. The CUPS web browser interface can be accessed from all supported browsers. Depending on the task that you are performing, you might be prompted for a user name and password, or for the root role and password.

Note the following requirements for using the CUPS web browser interface:

■ The CUPS software packages must be installed on the host that is accessing the CUPS web pages. If you are running the Oracle Solaris 11 release, these software packages are installed on your system by default.

    The following CUPS packages are required:
    ■ cups
    ■ cups-libs
    ■ foomatic-db
    ■ foomatic-db-engine

■ The CUPS scheduler, svc:/application/cups/scheduler, must also be running on the host.

    To verify that the CUPS scheduler is running, open a terminal window and type the following command:

    $ svcs cups/scheduler

    STATE STIME FMRI
    online 10:07:54 svc:/application/cups/scheduler:default

■ The JavaScript scripting language must be supported and enabled on the browser that you are using to access the CUPS web pages.

    Most current browsers support the use of the JavaScript language. To determine whether the JavaScript language is enabled, check your browser’s Preferences menu.

Troubleshooting Issues With Accessing the CUPS Web Browser Interface

If you encounter an error while attempting to access the CUPS web browser interface or you cannot access the interface, see “Requirements for Using the CUPS Web Browser Interface” on page 27 to ensure that all of the requirements have been met. In addition, verify your browser’s proxy settings to determine whether a proxy server has been configured. If so, try disabling the proxy server, then re-attempt to access the CUPS web browser interface.

To determine whether the CUPS web browser interface is running, you can also attempt to connect to the CUPS port (Port 631) by typing the telnet command in a terminal window, as follows:
mymachine% telnet localhost 631
Trying ::1...
Connected to mymachine
Escape character is "^]q"
^]q
telnet> q
Connection to mymachine closed.
mymachine%

To stop the telnet session, press the Control-]. To quit the telnet session, type q.

Print Administration Tasks

Common print administration tasks that you can perform by using the CUPS web browser interface include the following:

- Customizing a print server setup
- Pointing a print client to a common print server
- Setting up and managing directly-attached printers and printer classes on servers
- Setting up and managing remote printers and printer classes on servers
- Managing print jobs from print clients

When you first access the CUPS web browser interface at http://localhost:631, you see the Home tab. From this tab, you can access all of the print administration tasks, which are grouped together by category, as well as the full set of CUPS documentation.

The following tabs are displayed on the web browser interface’s main web page:

- Administration – Enables you to access most print administration tasks, including CUPS server configuration.
  You can directly access the Administration section of the web browser interface by going to http://localhost:631/admin.
- Classes – Enables you to search printer classes.
  CUPS provides collections of printers, which are called printer classes. Print jobs that are sent to a class are forwarded to the first available printer in that class. Classes can be members of other classes. Therefore, you can define very large, distributed printer classes for high-availability printing.
- Documentation – Enables you to access the CUPS documentation, which includes manuals, system administration documentation, FAQs, and online help.
- Jobs – Enables you to view and manage print jobs for configured printers.
- Printers – Enables you to view information about and modify the settings of a specified printer.
About the Administration Tab

Most printing tasks can be performed from the Administration tab. Note that some tasks can be performed from multiple tabs. Basic server settings can also be changed from the Administration tab. For more information about CUPS server configuration, see the cupsd.conf(5) man page.

The following figure shows the contents of the Administration tab of the CUPS web browser interface.

The following table describes the task categories and individual tasks that can be performed from the Administration tab.

<table>
<thead>
<tr>
<th>Task Category</th>
<th>Task Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printers</td>
<td>Add Printer</td>
</tr>
<tr>
<td></td>
<td>Find New Printers</td>
</tr>
<tr>
<td></td>
<td>Manage Printers</td>
</tr>
<tr>
<td>Classes</td>
<td>Add Class</td>
</tr>
<tr>
<td></td>
<td>Manage Classes</td>
</tr>
<tr>
<td>Jobs</td>
<td>Manage Jobs</td>
</tr>
</tbody>
</table>
### Task Category | Task Type
--- | ---
Server | ✷ Edit Configuration File  
| ✷ View Page Log

## About the Printers Tab

The Printers tab enables you to view and modify information for configured print queues, as illustrated in the following figure.

From the Printers tab, you can also perform the following tasks:

- Print a test page
- Stop the printer
- Reject a print job
- Move a print job
- Cancel all print jobs
- Unpublish the printer
- Modify a printer
- Set printer options
- Delete a printer
- Set the printer as the default
- Set allowed users for a printer

### How to Add a New Printer

1. **Access the Administration tab by going to `http://localhost:631/admin`.**
2. **Click the Add Printer button.**
3 If prompted, type your login user name and password, or log in as the root role and password.

4 Follow the prompts to complete the process.

About the CUPS Print Manager GUI

CUPS support includes a GUI, `system-config-printer`, which is accessible from the command line or from the desktop. Because CUPS is the default print service, detection of directly-attached printers is automatic. CUPS can also automatically discover other CUPS printers on a network, if those printers have sharing enabled. CUPS can also be configured to browse the network for Windows-hosted printers. For more information, see “Local Server Configuration” on page 33.

Note that when using CUPS Print Manager to perform a privileged action, such as creating a new print queue, modifying print queue properties, or deleting an existing print queue, you are prompted for the root password.

Starting CUPS Print Manager

To start the CUPS Print Manager GUI, use any one of the following methods:

- From the command line, type the following command:

  $ system-config-printer

- From the desktop’s Main Menubar, choose System → Administration → Print Manager.
Setting Up Printers by Using CUPS Print Manager (Task Map)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>For Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure a CUPS server to administer local print queues.</td>
<td>You can use CUPS Print Manager to configure a local server. The system acts as a local server for any printers that are physically connected to it and for any print queues that are created on that system.</td>
<td>&quot;Local Server Configuration&quot; on page 33</td>
</tr>
<tr>
<td>Configure a CUPS server to administer remote print queues.</td>
<td>You can use CUPS Print Manager to connect to a remote system, where you can administer print queues. The remote system must be configured to allow remote administration.</td>
<td>&quot;Remote Server Configuration&quot; on page 33</td>
</tr>
<tr>
<td>Set up a new local printer.</td>
<td>When you connect a new printer to your local system, the printer is automatically detected and its Properties dialog opens. From here, you can finish configuring the new printer by using the CUPS Print Manager GUI.</td>
<td>&quot;How to Set Up a New Local Printer&quot; on page 36</td>
</tr>
</tbody>
</table>
Setting Up Printers by Using CUPS Print Manager

This section describes tasks that are required to set up printers by using CUPS Print Manager.

Local Server Configuration

Each system that uses CUPS can be both a print server and a print client. The system acts as the server for any printer that is physically connected to it and for any print queues that are created on that system.

To configure advanced settings and options for a local CUPS server, start CUPS Print Manager, then choose Server → Settings. In the Basic Server Settings dialog, click the Advanced button. The following advanced server settings and options can be viewed or configured:

- **Job History** – Controls the print job history for a specified printer or printers
- **Browse Servers** – Enables you to restrict browsing by CUPS to certain print servers for the purpose of polling print queues

In the Basic Server Settings dialog you can configure the following settings:

- **Show printers that are shared by other systems** – Enables other CUPS print queues to be visible to the local system.
- **Publish shared printers connected to this system** – Publishes a list of print queues that are configured on a system to the other systems on a local area network (LAN). You can also publish print queues to be accessible beyond the LAN. The Allow Printing from the Internet option is only available if this setting has been selected.
- **Allow remote administration** – Enables you to administer the print queue from a remote system by using either CUPS Print Manager or the CUPS web browser interface.
- **Allow users to cancel any job (not just their own)** – Enables users to cancel any print jobs.
- **Save debugging information for troubleshooting** – Enables the logging of debugging information for troubleshooting purposes.

Remote Server Configuration

You can configure CUPS to administer print queues on a remote print server. Typically, you can connect to remote servers within the same local area network (LAN). Only those print queues that are owned by the remote print server to which you are connected can be modified. Each remote server determines whether its configured print queues can be shared or remotely modified based on the Settings dialog for the specified printer.
Published printers are printers that are publicly announced by the server on the LAN, based on how the `cupsd.conf` file has been configured for browsing. Shared or published printers can be detected by remote print clients but unshared or unpublished printers are not announced on the network.

Note – You must have appropriate authorizations to administer remote print queues. In the Oracle Solaris 11 release, you must provide the root password for the remote server.

How to Configure CUPS to Administer Remote Print Queues

1. Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop’s main menubar or by typing the following command in a terminal window:
   ```
   $ system-config-printer
   ```
2. From the Server menu, choose Settings.
   The Basic Server Settings dialog is displayed.
3. Select the following options:
   - Publish Shared Printers Connected to This System – Displays the shared or published printers that can be detected by remote print clients. If you do not enable this option, some printers might not be displayed in the list of available printers when you connect to the remote server.
   - Allow Remote Administration – Enables you to connect to a remote server.
4. Click OK.
5. From the Server menu, choose the Connect option.
   The Connect to CUPS Server dialog is displayed.
6. Select the desired remote server from the CUPS server list.
7. (Optional) If you require encryption, select the Require Encryption option.
8. Click the Connect button.
9. Type the root password for the remote system.
   You can now remotely administer print queues on the remote system in the same way that you administer local print queues.
Selecting a Print Device

When you set up a new printer or when you modify the properties of a configured printer, you must select an appropriate device for that printer. The following table describes the device choices that might be displayed in the Select Device window.

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>printer-name</td>
<td>Specifies a printer that has been automatically detected.</td>
<td>Select this device when setting up a new printer.</td>
</tr>
<tr>
<td>printer-name (serial-number)</td>
<td>Specifies a printer that has been automatically detected, and includes the serial number.</td>
<td>Select this device when setting up a newly detected printer. Note – Most often, this device is the same device as the printer-name device. The difference is that one entry contains the serial number of the printer, and the other entry does not. The reason two entries are listed for the same device is that both the system-config-printer back end and the HAL back end detect USB devices. When configuring a new printer, you can specify either device.</td>
</tr>
<tr>
<td>Serial Port # number</td>
<td>Specifies a device that is connected to the serial port of your local system.</td>
<td>Select this device when setting up a printer that is connected to your local system’s serial port.</td>
</tr>
<tr>
<td>AppSocket/HP Jet Direct</td>
<td>Specifies a device that uses a method of communication with network printers that is effectively a TCP connection.</td>
<td>Select this device when setting up remote print queues on a network.</td>
</tr>
<tr>
<td>Internet Printing Protocol (IPP)</td>
<td>Specifies a device that is used for network printer setup on a host that is running IPP.</td>
<td>Select this device when setting up newer printer models on a host that is running IPP.</td>
</tr>
<tr>
<td>LPD/LPR Host or Printer</td>
<td>Specifies a device that is used to connect to an LPD network printer.</td>
<td>Select this device when setting up remote print queues that use LPD. Note – This device might not work for more modern printer models.</td>
</tr>
</tbody>
</table>
### Device Description When to Use

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>Specifies a device that uses a Server Message Block (SMB) host on the network.</td>
<td>Select this device when setting up printers on Windows-hosted systems. Note – This device might not be displayed on all systems.</td>
</tr>
<tr>
<td>Other</td>
<td>Specifies a device that uses a device URI that is user-defined.</td>
<td>Select this device when setting up printers by specifying your own destination or device URI, for example, file:///dev/printers/0. Note that file: device uri support must be enabled under CUPS (cupsctl FileDevice=yes).</td>
</tr>
</tbody>
</table>

### How to Set Up a New Local Printer

The following procedure describes how to set up a new locally attached printer by using the CUPS Print Manager GUI.

1. **Connect the new printer to your local system, then power it on.**

   - When the printer is detected by the system, the Printer configuration dialog appears, displaying information about the newly detected printer.

   - If you are adding a new printer that was not automatically detected, do the following:

     a. Start CUPS Print Manager by choosing System → Administration → Print Manager from the desktop’s main menubar or by typing the following command in a terminal window:

        ```
        $ system-config-printer
        ```

     b. Choose Server → New → Printer from the main menu.

        Alternatively, you can click the New icon that is located on the menubar.

     c. **When prompted, type the root password.**

        The Printer configuration dialog appears, displaying all of the configured printers and the newly connected printer.

2. **In the Select Device window, select the appropriate device, then click Forward.**

   By default, CUPS selects the USB device that is physically connected to your system or the device that was detected by HAL. Note that these two entries might be for the same printer. For more information about selecting a device, see "Selecting a Print Device" on page 35.
3 In the Choose Driver window, select a make for your printer, then click Forward.

4 Determine whether to accept the default printer driver or provide a PPD file.
   - To use the default driver, leave the Select Printer From Database option selected.
   - To provide a PPD file:
     a. Select the Provide PPD File option.
        The Select a File window is displayed.
     b. Locate the specified PPD file on your system, then click Open to associate the PPD file with the new printer.

5 From the left pane of the next Choose Driver window, select a printer model. From the right pane, select a printer driver. Then, click Forward.
   By default, CUPS selects a “recommended” printer model and driver for your printer. However, you can optionally make another selection from the list of available drivers.

6 In the Installable Options window, change any of the options that are available for your particular printer model, then click Forward.
   For more information, see “Configurable Printer Properties” on page 40.

7 In the Describe Printer window, provide the following information:
   - Printer Name
   - Description
   - Location

8 To save your changes, click Apply. If prompted, type the root password.
   After you have saved your changes, the newly configured printer is displayed in the CUPS Print Manager window.

9 (Optional) To set the printer as the default, right-click the printer name.
   a. Choose the Set as Default option.
   b. In the Set Default Printer window, choose one of the following options:
      - Set as the system-wide default printer (default)
      - Set as my personal default printer

10 Click OK to save the printer configuration.
11 (Optional) To verify that the printer is configured correctly and is working, print a test page.
Administering Printers by Using CUPS Print Manager (Tasks)

This chapter includes information for managing your printing environment by using the Common UNIX Printing System (CUPS), including how to transition to using CUPS if you previously used the LP print service to manage printers. The interfaces that are described in this chapter include the CUPS command-line utilities, the CUPS web browser interface, and CUPS Print Manager, a GUI that can be accessed in the desktop.

### Administering Printers by Using CUPS Print Manager (Task Map)

<table>
<thead>
<tr>
<th>Task</th>
<th>For Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the properties of a configured printer.</td>
<td>“How to Modify the Properties of a Configured Printer” on page 41</td>
</tr>
<tr>
<td>Rename or copy a printer configuration.</td>
<td>“How to Rename a Printer” on page 43</td>
</tr>
<tr>
<td>Delete an existing printer.</td>
<td>“How to Delete a Printer” on page 44</td>
</tr>
<tr>
<td>Unshare or share a printer.</td>
<td>“How to Unshare or Share a Printer” on page 44</td>
</tr>
<tr>
<td>Disable or enable a printer.</td>
<td>“How to Disable or Enable a Printer” on page 44</td>
</tr>
<tr>
<td>Manage print jobs for configured printers.</td>
<td>“How to Manage Print Jobs for a Specified Printer” on page 45</td>
</tr>
</tbody>
</table>
Administering Printers by Using CUPS Print Manager

This section describes how to administer printers by using CUPS Print Manager.

Configurable Printer Properties

Use the options in the Printer Properties dialog to modify the properties of a configured printer. For instructions, see “How to Modify the Properties of a Configured Printer” on page 41.

The Printer Properties dialog includes the following six sections for configuring new and existing printers:

- **Settings**
  In the Settings section, you can configure the following properties:
  - **Description** Descriptive text about the printer.
  - **Location** A description of the physical location of the printer.
  - **Device URI** Information about the protocol that is used to access the printer. For example, you could use LPD to specify the RFC-1179 protocol or IPP to specify the Internet Printing Protocol.
  - **Make and Model** Information about the make and model of the printer. The default setting for the Make and Model option can be changed by clicking the Change button.
  - **Printer State** Information about the current status of the printer.
  - **Tests and Maintenance** Contains the following options:
    - Print Test Page
    - Print Self-Test Page
    - Clean Print Heads

- **Policies**
  In the Policies section, you can configure the properties that control how a printer behaves.
  - **State** Specifies the following printer states:
    - Enabled
    - Accepting Requests
    - Shared
    Note that more than one state can be specified at the same time.
  - **Policies** Specifies how the printer behaves during error conditions.
Banner Specifies whether starting or ending banner pages are printed with each print job.

- **Access Control**
  The Allow or Deny lists determine which users can print to the printer.

- **Printer Options**
  In the Printer Options section, you can configure printer-specific options.
  For example, for an HP LaserJet 3015, the following configurable options are displayed:
  - Imaging Options
  - Resolution Options
  - Watermark/Overlay
  
The number and types of options are determined by the PPD file that is associated with the specified printer.

- **Job Options**
  Determines the options that are associated with a print job, for example, the number of copies and page orientation, as well as certain image options. The number and types of options are determined by the PPD file that is associated with the specified printer.

▼ **How to Modify the Properties of a Configured Printer**

The following procedure describes how to modify the basic configuration of an existing printer. For a complete description of all of the properties that you can modify by using the CUPS Print Manager GUI, see “Configurable Printer Properties” on page 40.

1. **Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop’s main menubar or by typing the following command in a terminal window:**
   ```
   $ system-config-printer
   ```
   The Printer configuration dialog is displayed listing all of the configured printers and any newly detected printers.

2. **Right-click the name of the printer for which you want to modify the properties, then choose Properties.**
   The Printer Properties dialog appears. The Properties dialog contains five separate sections, each of which contains properties that are grouped by category. By default, the Settings section of the dialog is displayed.
   In the Settings section, you can modify the following settings:
   - Description
   - Location
1. Device URI
2. Make and Model

3. To modify the printer description or location, type the new information in the corresponding text field.

4. To modify the device URI:
   a. Click the Change button next to the setting.
   b. From the list of available devices, select a device, then click Apply.
      For a description of the available devices, see “Selecting a Print Device” on page 35.
   c. When prompted, type the root password.
      You are returned to the Settings section.

5. To modify the printer make and model:
   a. Click the Change button next to the setting.
   b. In the Choose Driver window, select a printer make, then click Forward.
      
      Note – By default, CUPS uses the Select Printer From Database option and selects the appropriate printer-make for you. Alternatively, you can provide your own PPD file. For instructions, see Step 3 of “How to Set Up a New Local Printer” on page 36.
   c. From the left pane of the next Choose Driver window, select a printer model. From the right pane, select a printer driver, then click Forward.
   d. In the Existing Settings dialog, choose from the following options, then click Apply.
      - Use the new PPD as is.
      - Try to copy the option settings over from the old PPD.
   e. If prompted, type the root password.
      You are returned to the Settings section of the Printer Properties dialog.

6. Click OK.
How to Rename a Printer

1. Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop's main menubar or by typing the following command in a terminal window:

   $ system-config-printer

   The Printer configuration dialog appears, listing all of the configured printers and any newly detected printers.

2. Right-click the name of the printer that you want to rename.

3. Choose the Rename option.

4. Type a new name for the printer.

5. Type the root password when prompted.

6. Click OK to save the changes.

How to Copy a Printer Configuration

1. Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop's main menubar or by typing the following command in a terminal window:

   $ system-config-printer

   The Printer configuration dialog appears, listing all of the configured printers and any newly detected printers.

2. Right-click the name of the printer that you want to copy the configuration.

3. Choose the Copy option.

4. In the Copy Printer window, type a name for the printer, then click OK.

5. Type the root password when prompted.

6. Click OK.
How to Delete a Printer

1 Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop's main menubar or by typing the following command in a terminal window:

```
$ system-config-printer
```

The Printer configuration dialog appears, listing all of the configured printers and any newly detected printers.

2 Right-click the name of the printer that you want to delete, then choose Delete.

3 Click OK in the Confirm Deletion dialog.

How to Unshare or Share a Printer

By default, new printers are configured with the Share option enabled, which means they are published on the local network. This procedure describes how to unshare a printer or enable an unshared printer.

1 Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop's main menubar or by typing the following command in a terminal window:

```
$ system-config-printer
```

The Printer configuration dialog appears, listing all of the configured printers and any newly detected printers.

2 Right-click the printer name that you want to unshare, or share.

3 Select Share or Unshare option according to your requirement.

4 Type the root password when prompted.

5 Click OK.

How to Disable or Enable a Printer

When you configure a new printer by using CUPS Print Manager, the printer is enabled by default. This procedure describes how to disable or enable a printer.

1 Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop's main menubar or by typing the following command in a terminal window:

```
$ system-config-printer
```
The Printer configuration dialog appears, listing all of the configured printers and any newly detected printers.

2 Right-click the name of the printer that you want to disable, or enable.

3 Select Enable or Disable option according to your requirement.

4 Type the root password when prompted.

5 Click OK.

▼ How to Manage Print Jobs for a Specified Printer

1 Start the CUPS Print Manager GUI by choosing System → Administration → Print Manager from the desktop's main menubar or by typing the following command in a terminal window:

   $ system-config-printer

   The Printer configuration dialog appears, listing all of the configured printers and any newly detected printers.

2 Right-click the name of the printer for which you want to manage print jobs, then choose View Print Queue.

   The Document Print Status (printer-name) window appears, listing all of the print jobs for the specified printer.

   In this window, you can view the following information:
   - Job
   - User
   - Document
   - Printer size
   - Time submitted
   - Status

3 To view information about completed jobs or printer status, select the appropriate option from the View menu.

4 To perform a specific action on a print job, select the print job, then select an action from the available choices on the menubar.

   Alternatively, you can right-click the name of a print job, and from the list of available options, select an action.

   You can view the following actions:
5 (Optional) To refresh the View Print Queue window, choose View → Refresh.
Index

A
accessing the CUPS web browser interface, 27
add a new printer, using CUPS web browser interface, 30–31
administering printers, using the CUPS web browser interface, 26
administering remote print queues, configuring CUPS, 33–34
advanced server configuration, CUPS, 33

C
command-line utilities, CUPS, 15–16
command-line utilities, CUPS, 7–9
common print administration tasks, 28
configuring a print server, CUPS, 33
configuring CUPS, remote print queue administration, 33–34
copying a printer configuration using CUPS, 43
CUPS
administering remote print queues, 33–34
configuring printer properties, 40–41
how to enable and disable a printer, 44–45
how to manage print jobs, 45–46
how to modify printer properties, 41–42
how to rename or copy a printer, 43
how to share and unshare a printer, 44
selecting a print device, 35–36
CUPS GUI
deleting a printer, 44

CUPS GUI (Continued)
setting up a local printer, 36–38
using to select a print device, 35–36
CUPS introduction, 7–9
CUPS Print Manager GUI, 7–9
CUPS print server, configuring advanced settings, 33
CUPS scheduler, 27
CUPS services, 8

default printer
command line, 18–20
LPDEST variable, 18–20
PRINTER variable, 18–20
deleting a printer, using CUPS, 44
device, how to select when using CUPS, 35–36
disabling a printer, using CUPS, 44–45

e
enabling a printer, using CUPS, 44–45

H
how to add network printer, 24–25
how to delete a printer, 22–23
how to list the available devices, 25–26
how to list the available drivers, 25–26
how to remove printer access, 22–23
how to set up a printer
  on a different subnet  
    using CUPS commands, 24–25  
    using CUPS commands, 16–17  
how to set up your printing environment, 12–13

L
local printer
  how to set up  
    CUPS, 36–38
local server configuration, CUPS, 33
lp
  print  
    secondary printer, 20
lp command  
  to print file  
    default printer, 22
lpadmin command, to set up a printer, 16–17
lpstat command, verify printer status, 20–22

M
managing print jobs, using CUPS, 45–46
managing print requests, using CUPS, 9
methods to start CUPS Print Manager GUI, 31
modify printer properties, using CUPS, 41–42

O
overview  
  CUPS, 7–9  
  CUPS Print Manager GUI, 31  
  system-config-printer, 31

P
print device  
  selecting  
    CUPS, 35–36  
  print file, default printer, 22
print jobs, using CUPS to manage, 45–46
print queue, CUPS, 8
print to a specified printer, 20
printer  
  how to delete  
    using CUPS, 44
printer properties  
    using CUPS, 40–41  
    using CUPS to modify, 41–42
printer setup, using CUPS GUI, 36–38
printers  
  enabling and disabling  
    CUPS, 44–45  
  sharing and unsharing  
    CUPS, 44
printers properties  
  configuring a printer  
    CUPS, 40–41

R
remote print queues, configuring CUPS, 33–34
renaming a printer  
  using CUPS, 43
requirements, CUPS web browser interface, 27

S
Setting a default printer, using CUPS commands, 17–20
setting up network printer, using CUPS commands, 24–26
setting up print queues, using CUPS, 9
setting up printers  
  using CUPS, 9, 11–38  
  using the CUPS web browser interface, 26
setting up printing environment, 11–13  
  using command-line utilities, 14
setting up printing environment for an upgrade, 13
sharing a printer, using CUPS, 44
Index

T
tabs
  administration tab
    CUPS web browser interface, 29–30
    CUPS web browser interface, 28
  printers tab
    CUPS web browser interface, 30
Troubleshooting, CUPS web browser interface, 27–28

U
unsharing a printer, using CUPS, 44

V
verify status, printers, 20–22

W
web browser interface, CUPS, 7–9